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ABSTRACT—

With all the development of modern technology and Android Smartphone, Good Living is slowly but

surely changing people’s life. Bluetooth technology, which should exchange info wirelessly within a brief distance
using short-wavelength a radio station transmissions, is providing a crucial technology to create comfort, intelligence
and controllability. In this paper, an innovative Smart Living system named home lighting control program using
Bluetooth-based Android Smart phone is proposed and prototyped. First Smartphone, Smart Living and Bluetooth
technology happen to be reviewed. Second the program structures, communication protocol and components design are
described. In that case the design of a Bluetooth-based Smartphone application and the prototype are provided. It is
proven that Android Smartphone provides a platform to implement Bluetooth-based application for Smart Living.
KEYWORDS – ICU patient, SMS, doller Cs, temp, heartbeat, blood pressure, ARM microcontroller, GSM module.
I. INTRODUCTION
Nowadays, smart phones are getting to be more powerful with strengthened processors, larger storage features,
richer entertainment functions and more communication methods. Wireless, which is mainly employed for data
exchange, responsibilities features to smart cell phones. Bluetooth technology, created by simply telecom vendor
Ericsson in 1994 [1], reveals its advantage by including with smart phones. That has changed how persons use digital
devices in home or office, and has transferred traditional born digital devices into mobile devices. A host Wireless
device is capable of communicating with approximately eight Bluetooth modules concurrently through one link [2].
Considering its normal functioning area of within 8 meters, it is specifically within a home environment. Due to
Bluetooth technology and other similar techniques, the concept of Smart Living has offered better prospect in
convenience, comfort and security which includes central control of air-con,, light, heating and cooling in home, and
service automated programs[3] [4]. With dramatic increase in smart phone users, androids have slowly but surely
turned in an all-purpose lightweight system and provided persons intended for their daily use [5]. Recently, an opensource platform Android has recently been widely used in androids [6]. Android provides a complete software
package consisting of a computer, middleware coating, and core applications. Diverse from other existing websites
like iOS (iPhone OS), it comes with Computer software Development Kit (SDK), which offers essential tools and
App.
With the development of technology as well as the continuous improvement of people's living normal, persons are in
search of automated, intelligent and practical home control systems. At the moment, the PC can be used while the
remote control airport terminal for some home control devices; nevertheless , there are several problems in the
PERSONAL COMPUTER monitor terminal, such while its great bulk, hassle to transport, high cost, limited
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monitoring range and therefore on. Therefore, it’s a great choice to design an airport terminal depending on phone.
With the popularity of iPhone, specifically, the phone based upon Android system is swiftly developed. In its I/O
developer conference, Google demonstrated a sneak preview of its Android Home task, which will extend the Android
platform into home objects. It ensures that the remote control based in Android phone can be a mainstream way. After
working into the control software, users may easily control the lights, TVs and air flow conditionings anytime,
anywhere, which in turn brings great convenience to persons and increases the standard of life.
II. LITERATURE SURVEY
In this proposed Seminar, following IEEE papers were studied within just literature survey. Smart Residence System
for Disabled Persons Via Wireless Bluetooth provides moneywise concept by applying GPRS as the method to manage
and monitor residence appliances.
Design and Recognition of Appliances for the home Control Program Based on The Google android Smartphone
present the info on the remote appliances control system based on the Android smart phone is usually designed and
realized. A user logs in the intelligent phone interface, and clicks the buttons gently to deliver message commands
which in turn will be transmitted to home information Centre through the GSM network. After that the PIC processor
understands the specified command, and controls the home product switches in the cordless radio frequency manner to
achieve handy remote control of home appliances ultimately. Exploiting Bluetooth about android mobile phones
pertaining to home security application present the information regarding mobile devoice has been integrated in our
everyday activities. Home motorisation and security are turning out to be increasingly prominent features upon mobile
devoices the portable devoice and security alarm convey via Bluetooth must be short-range-only communication
system was wanted. With the help of android mobile we can easily control task including fastening the doors, turning
on and off lights remotely. According to kaue, home automation may be handy to all those who need to gain access to
cookware while away by their home and may increase the lives of the incapable.
A Brief history of AVR:
1] ATMEGA32:
The AVR is a Modified Harvard architecture 8-bit RISC single chip microcontroller (µC) which was manufactured by
Atmel in 1996. The AVR was one of the first microcontroller households to use on-chip show memory for program
safe-keeping, as opposed to 1-time Programmable ROM, EPROM, or perhaps EEPROM employed by other
microcontrollers at the time.
BRANDED CIRCUIT BOARD
PCB means printed circuit board PCB is one of the main factors in any digital system. They accomplish the
interconnection the between part mounted on them in particular manner PCB incorporate conductive circuit pattern
which in turn can be applied to one or both on the sides of an insulating foundation copper is most extensively used for
conductor materials. Aluminum nickel, silver, metal is employed for same unique application.
The thickness of conducting material depends after the current carrying potential of circuit. Thus a thicker
conductor layer could have mare current carrying potential once the PCB is definitely created the current having
capacity is is determined by which will of conductor track.
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The printed circuit board usually serves there distinct functions are as follows:
•

It provides mechanical support for the component mounted on it.

•

It provides necessary electrical interconnections.

•

It acts as a heat sink i.e. it provides a conduction path leading to removal of most of the heat generate in the

circuit.
Advantage of PCB: Over the conventional wire method:
•

PCB’s have controllable and predicable electrical mechanical properties.

•

Rapid production is possible.

•

Time is saved since it avoids wiring connections production to another

•

Weight is reduced.

•

Soldering is done in one operation instead of individual connection between component and wires.

•

Cost is less.

III. PROBLEM DEFINITION
WHY AVR?
AVRs have been used in various automotive applications such as security, safety, power train and entertainment
systems. Atmel has recently launched a new publication "Atmel Automotive Compilation" to help developers with
automotive applications. Some current usages are in BMW, Daimler-Chrysler and TRW.
System Semiconductor, Inc produces the M3000 Motor and Motion Control Chip, incorporating an Atmel AVR Core
and an Advanced Motion Controller for use in a variety of motion applications.
The New 32-Bit AVRs:
In 2006 Atmel released microcontrollers based on the new, 32-bit, AVR32 architecture. They include SIMD and DSP
instructions, along with other audio and video processing features. This 32-bit family of devices is intended to compete
with the ARM based processors.
Due to lot of features in built it is very cost effective and easy to build a controller.
TECHNICAL DETAILS OF AVR
High-performance, Low-power AVR® 8-bit Microcontroller
Advanced RISC Architecture
131 Powerful Instructions – Most Single-clock Cycle Execution
32 x 8 General Purpose Working Registers
On-chip 2-cycle Multiplier
Non-volatile Program and Data Memories
32K Bytes of In-System Self-Programmable Flash
Endurance: 10,000 Write/Erase Cycles
In-System Programming by On-chip Boot Program
True Read-While-Write Operation
1024 Bytes EEPROM\
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Endurance: 100,000 Write/Erase Cycles
2K Byte Internal SRAM
Programming Lock for Software Security
JTAG (IEEE std. 1149.1 Compliant) Interface
Boundary-scan Capabilities According to the JTAG Standard
Extensive On-chip Debug Support
Programming of Flash, EEPROM, Fuses, and Lock Bits through the JTAG Interface.

IV. PROPOSED SOLUTION
ARCHITECTURE

With new versions of Android OS coming every few months we would like to select a version which is quite popular.
We will target the Android Version 2.1 Éclair and above. As per statistics android version 2.1+ covers 67% of the total
Android Devices being used. The 2.1 Platform also provides with many more Application Package Interfaces such as
Bluetooth SDAP and CANVAS API. These API allow us to graphically design our software with less knowledge of the
actual core JAVA coding. Also Android phones come for as cheap as Rs.5400/-

USAGE SHARE:
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Android is a software stack for mobile devices that includes an operating system, middleware and key applications. The
Android SDK provides the tools and APIs necessary to begin developing applications on the Android platform using
the Java programming language.
APPLICATIONS
Android will ship with a set of core applications including an email client, SMS program, calendar, maps, browser,
contacts, and others. All applications are written using the Java programming language.
APPLICATION FUNDAMENTALS
Android os applications are written inside the Java programming vocabulary. The Android SDK equipment compile the
code—along with any data and source files—into an Android bundle, an archive file with an. apk suffix. Most the code
within a. apk file is considered to be one application and is the file that Android-powered devices value to set up the
application.
Once set up over a device, each Android os application lives in the own security sandbox:
•

The Android operating system is known as a multi-user Linux system through which each application is a

different user.
•

An program can request permission to access device data including the user's contacts, SMS emails, the

mountable storage (SD card), camera, Bluetooth, and more. All application accord must be granted by simply the user
at set up time.
That covers the basics regarding how a great Android application exists in the system. The rest of this document
introduces you to:
•

The core structure elements that define the application.

•

The manifest document when you declare elements and required device features for your application.

•

Resources that are separate through the application code and enable the application to superbly optimize its

behaviour intended for a variety of gadget configurations.
BLUETOOTH CONNECTIVITY
The Android platform includes support for the Bluetooth network stack, which allows a device to wirelessly exchange
data with other Bluetooth devices. The application framework provides access to the Bluetooth functionality through
the Android Bluetooth APIs. These APIs let applications wirelessly connect to other Bluetooth devices, enabling pointto-point and multipoint wireless features.
Using the Bluetooth APIs, an Android application can perform the following:
•

Scan for other Bluetooth devices

•

Query the local Bluetooth adapter for paired Bluetooth devices

•

Establish RFCOMM channels

•

Connect to other devices through service discovery

•

Transfer data to and from other devices

•

Manage multiple connections

HC 05
•

What is Bluetooth?

•

Goals
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•

Requirements

•

Usage Models

•

Bluetooth Architecture

•

Security

V. IMPLEMENTATION
SOFTWARE USED:
•

MULTISIM

•

AVR STUDIO
a) AVR STUDIO OVERVIEW

AVR Studio is an Expansion Tool for the AT90S Number of AVR microcontrollers. This kind of manual describes the
just how to install and work with AVR Studio. AVR Studio room permits you fully control execution of programs in
the AT90S In-Circuit Emulator or on the integrated AVR Instruction Set Sim. AVR Studio supports supply level
execution of Set up programs assembled with the Atmel Corporation's AVR Lier and C programs created with IAR
Systems’ ICCA90 C Compiler for the AVR microcontrollers. AVR Facilities runs under Microsoft Windows95 and
Microsoft Windows NT.
AVR Studio is sent on two diskettes. Notice that sometimes, the second diskette will not get called for by the unit
installation program. This is due to some of the files required to run AVR Studio may well be present in the system. In
order to install AVR Studio underneath Windows95 and Windows NT 4. 0:
1.

Place the diskette labeled AVR Studio Diskette 1 in drive A:

2.

Press the beginning button about the Taskbar and select Run

3.

Enter “A: SETUP” in the Start field and press the OK press button

4.

Comply with the instructions inside the Setup program

In purchase to install AVR Studio room under Windows NT several. 51:
1.

Put in the diskette labeled AVR Studio Diskette 1 in drive A:

2.

Instalment obligations on your Select Manage from the File menu

3.

Enter “A: SETUP” in the Command Series field and press the OK button

4.

The actual instructions in the Create software

Once AVR Facilities has become installed, it may be started by dual clicking the AVR Studio room icon. If an
Emulator is the desired performance target, remember to hook up the AVR In- Routine Emulator prior to starting AVR
Studio room.
These are things we all are using for code:
Starting AVR Studio
Begin the AVR Studio software by clicking on:
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•

Start-> Programs-> ATMEL AVR Tools-> AVR Studio 4

.
Fig 2. Creating a New Project

Click on the “New Project” button:

Fig 3. Welcome dialog Box

In this tutorial we will make a simple program that increases the value of one of the PORT registers, making a binary
counter. To create a new project, click on "Create New Project" on the Welcome Screen or go to the "Project" menu
and select "New". The dialog box shown in the next figure appears.
In the next dialog box, choose the Atmel AVR Assembler as the project type:

Fig 4. Choose Atmel AVR Assembler

Type in a project name and the initial file name:
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Fig 5. Type Project and Initial file name

In this dialog box you should enter the project name. We choose the name led here, but this could of course be an
arbitrary name. Next you'll have to select the project location. This is the location where AVR Studio will store all files
associated with the project. We have used the location H:\comp1300\pracs\ as the folder. If the folder does not exist,
AVR Studio will ask you whether to create it or not. Select "Atmel AVR Assembler" as the project type.
Click "Next >>" and you will see a window like the following:

Fig 6. Select "AVR Simulator" as the debug platform and "ATMEGA16" as the device to use, then click "Finish".

Fig 7 .The main AVR window will now look like this:

We can now enter the Assembly code of the program. (AVR Studio has opened an editor window called led.asm).
Alternatively you can add or create other assembly language files by right clicking on "Assembler" in the Workspace
window:
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The led.asm file is automatically marked as "Assembler Entry File" (the small red arrow on the icon next to the
filename shows this). This indicates that the assembler will start with this file when assembling the project. The
"Assembler Files" group can only contain one file marked as an entry file.

Assemble the Source Code
To assemble the code, we need to build the project. Select "Build" from the Project menu (or press <F7>):

Simulating the Code
At this point we have generated the files needed to simulate the code. To start running the code, select "Start
Debugging" from the "Debug" menu:

Modifying the Code
Now we want the program to count down instead of up. To make this change we'll have to edit the source code. Place
the cursor in the source view, and change the inc to a dec instruction. If you now press <F5> (Go) the following dialog
box will appear. This box indicates that one of the source files has been changed, and that the project should be rebuilt.
Press "Yes".
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Saving the Project
Before exiting AVR Studio we will save our project. AVR Studio will remember where the views are placed and will
use this setting when opening the project later. To save the project select "Save Project" from the "Project" menu.
VI. CONCLUSION
The goal of the paper is to know the Smart Living, more especially the residence lighting control system applying
Bluetooth technology. The machine offers been successfully designed and prototyped to monitor and control the
lighting position using an Android Bluetooth-enabled phone and Bluetooth quests via BF10-A. The microchip can be
used to assist acquiring status in the lighting and provides interface to regulate the lighting. The Bluetooth component
sends and receives directions from the Bluetooth-enabled mobile phone and RFCOMM protocol can be used in
communication among Wireless bluetooth devices. Android system JDK is employed to develop the system, which can
end up being proved to be incredibly efficient and convenient. This is concluded that Good Living will slowly but
surely turn into a reality that buyers can control their residence remotely and wirelessly.
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